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ABSTRACT 

 

DYNAMIC RESPONSE MODELING OF HIGH SPEED PLANING CRAFT WITH 

ENFORCED ACCELERATION 

 

Brian K. Johnson 

Old Dominion University, 2018 

Co-Directors: Dr. Gene Hou  

                                   Dr. Jennifer Michaeli 

 

Due to the harsh conditions high speed planing crafts must endure, research to further the 

understanding of high speed vessel response during wave impacts was conducted. The 

integration of a finite element model and captured sea trial acceleration data was investigated. 

The research shows that the finite element model sub-model can be used in lieu of a full finite 

element model with minimum degradation in output, thus allowing for the analysis of local stress 

concentrations where critical equipment and or personnel may be located.  

The research effort was completed to develop a method for realizing the stress field and 

deformation generated following a wave impact. Application of base excitation was investigated 

and allowed for multiple studies to be completed. Validation of the method was accomplished 

through comparison of sea trial data with MSC NASTRAN transient response output in the form 

of acceleration. The method provides insight into the effect that wave impacts have on small 

vessels at sea, specifically the 11-meter cabin RIB, hull 11MRIB0503. 
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CHAPTER 1 

1. INTRODUCTION 

This chapter is dedicated to the discussion of the motivation behind the research effort, 

objectives, and the approach taken to complete the study.  

1.1 Motivation 

Over the years, researchers have investigated the effects that different sea conditions have 

on sea vessels. Sloshing, green water, and slamming are transient excitations that occur during 

said sea conditions and can be detrimental to at sea performance. In addition to sea conditions, 

hull form greatly effects how a vessel is able to move through the water.  Small fast vessels are 

usually equipped with planing hulls to increase speed. The planing hull will generate locally high 

hydrodynamic pressure in high speed so as to reduce friction drag and wave resistance. 

Unfortunately, a planing hull craft often encounters high slamming loads with high encountering 

frequency. Such slamming can suddenly alter sailing direction and speed. In addition to 

operability challenges, the high g-forces encountered while aboard a high speed planing craft are 

known to be harmful to the individuals aboard. The combination of craft speed and wave height 

creates hazardous conditions, not only for those individuals aboard but also for the traversing sea 

vessel itself, from boat hull to onboard equipment. In order to mitigate risk, it is important that 

steps are taken to ensure the sea vessel is structurally sound for the safety of the warfighters. 

1.2 Objectives   

The objectives of this investigation were multi-fold. Provided with a finite element model, 

built by Naval Surface Warfare Center Carderock Division, Detachment Norfolk (NSWCCD 

DN) Code 60 personnel using commercial code FEMAP, Old Dominion University researchers 

investigated the feasibility of using commercial code PATRAN and MSC NASTRAN to validate 
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the finite element model against data collected during multiple NSWCCD Code 80 sea trials. 

The procedures discussed, can be carried out to provide insight into how well a finite element 

model represents actual events at sea without finding the actual wave loads. 

The first objective of this work was to validate the finite element model built by 

NSWCCD Code 60 through transient analysis. The transient analysis was completed using full-

scale vertical acceleration data collected by NSWCCD Code 80. The second objective was to 

investigate the effect of number and placement of accelerometers used for enforced excitation. 

The third objective was to investigate the effects of enforced excitation on the pilot cabin. 

With continued advances in technology, institutions, more than ever, have the ability to 

take advantage of modeling and simulation software tools. However, errors in input can easily 

lead to misleading information. Therefore, it is important that proper methods be used during the 

application of such software tools within a study. With a well-defined and tested procedure, 

multiple institutions can adopt, compare results, and contribute. If the representation is accurate, 

insight into the local and global stress and displacement are obtainable, as will be shown.  

This study provides the community of interest with a procedure for modeling the effects 

of wave impact. Through simulation, visualization of the effects of changing said accelerometer 

inputs and filtering parameters is achievable. 

This work provides an acceleration load input method for finite element based dynamic 

analysis of a seagoing vessel. The study will show the integration of a finite element model with 

acceleration data to approximate stress and displacement values in the absence of strain gauges, 

pressure transducers, or computational fluid dynamics models employed in other model based 

research efforts. It is shown how this approximation method is considered adequate for analysis 

of the cabin region. The cabin is of interest as numerous research efforts have been conducted for 
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seat mitigation and have stated the hazard to shipboard equipment but lack the recorded data 

from strain gauges or pressure transducers. The integration will provide additional insight into 

the effect of wave impact on a high speed planing craft. 

In order to broaden the knowledge base on the finite element analysis software utilized by 

the Naval Engineering and Marine Systems Institute, both results and procedures are discussed. 

The compilation of research conducted in this field of study will facilitate researchers interested 

in base excitation, model validation, and finite element analysis. In addition to multiple research 

interests, this document is meant to serve as a manual for conducting transient analysis. 

Therefore, instructional reference material on how to implement investigations using the 

PATRAN and MSC NASTRAN software was outlined in Appendix A.  

Overall, the benefit of this research is to show that a smaller amount of data, both 

accelerometers and model size, are able to provide beneficial insight into the effect that sea states 

have on equipment and personnel out at sea. The method applied can provide advice on where 

bulkhead accelerometers should be located to analyze the entire cabin. This way, less time is 

spent developing a full model, and the areas of most concern such as warfighter seats and critical 

cabin equipment can be analyzed for design improvements. 

1.3 Approach 

Over the years, researchers have investigated the effects that different sea states have on 

sea vessels. The interest in predicting hull transformations over the course of vessel use has led 

to the application of empirical equations, theoretical models, and small-scale simulations. This 

research effort was initiated to show how acceleration data can be leveraged by researchers to 

predict the location of stress concentrations due to wave slamming. The application is driven by 

the method known as base excitation. Acceleration data was used as direct input during transient 
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analysis to observe the resulting stress along the sea vessel, specifically the cabin space, where 

the warfighter may be located during travel. The use of acceleration as an input was validated by 

enforcing acceleration data about specific nodes and recording the resulting acceleration output 

at the bottom, midsection, and top of the pilot cabin. The resulting acceleration was then 

compared to the acceleration output from sea trials.  

In order to accomplish the three objectives previously discussed, multiple investigations 

were completed. The investigations are detailed in the order in which they appear in the current 

work. First, a literature review of previous research conducted regarding enforced acceleration 

analysis and high speed planing crafts was completed. Second, finite element model validation 

through forced excitation and comparison to sea trial data was completed. Third, an investigation 

of quantity and placement for forced acceleration input using sea trial data was conducted. 

Fourth, enforced acceleration through isolated pilot cabin was completed. 

 In order to provide guidance, the scope of this thesis is briefed. The literature review is 

discussed in Chapter 2. The finite element model validation is discussed in Chapter 3. The 

investigation into quantity and placement of accelerometers is detailed in Chapter 4. Enforced 

acceleration through isolated pilot cabin was completed in Chapter 4. The thesis conclusion and 

recommendations are provided in Chapter 5. 
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CHAPTER 2 

2. BACKGROUND 

This chapter is dedicated to the discussion of the literature reviewed to form the basis of 

this research effort and the supplied data utilized during the completion of this research effort. 

2.1 Literature Review  

The slamming phenomena of a planing hull involves fully coupled dynamic interaction 

between fluid, structure, wind, wave, and the vessel itself.  To fully understand the slamming 

phenomena and its consequences on the design and operation of a planing hull is very 

challenging and has drawn the attention of many researchers in the past. To aid these efforts, 

many drop tests of wedges, towing tank tests, sea trails, and numerical simulations have been 

conducted to collect the data on point accelerations, pressures, and strains on the planing hull.  

Based upon the collected data, Allen, Jones & Taylor (1978) introduced a semi-empirical 

equation that correlates the impact pressure to the value of the 1/10th highest peak vertical 

acceleration. The value of the 1/10th highest peak vertical acceleration can be experimentally 

measured or approximated in terms of wave height, forward speed, and geometry features of the 

boat (Hoggard & Jones, 1980). Similar semi-empirical equations with different levels of average 

acceleration have been developed and incorporated in design and safety rules, chosen by the 

classification societies such as American Bureau of Shipping (ABS), Det Norske Veritas (DNV), 

or Lloyd’s Register (Grimsley, Liu, & Hou, 2010). The exponential distribution has been wildly 

used, which was suggested early by Fridsma (1971), to estimate different levels of the averaged 

acceleration based upon the same set of statistical parameters of the collected acceleration time 

series. 
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Recent studies have cautioned the use of the Allen and Jones’ equation. These new 

investigations have come about by conducting new experiments or by numerical simulation. 

Riley et al. (2010, 2016) have pointed out the need of standardizing the definition of a slamming 

event so as to better characterize acceleration data. Razola et al. (2014) improved the accuracy of 

the Allen and Jones’ equation by modifying the existing load-carrying area aspect ratio and 

adding a new one, the load transverse reduction factor. Furthermore, some researchers have 

questioned the use of the exponential distribution to quantify the peak acceleration data (Razola, 

et al. 2016; VanDerwerken & Judge, 2017). Others have called for a dynamic structural analysis 

of a planing hull in a slamming event. Rozola et al. (2014) indicated that to design a planing hull 

serving for a long life requires the understanding of local deformation and stresses under extreme 

slamming pressure. Joo et al. (2017) and Riley & Petersen (2017) pointed out the need of a 

pointwise impulse acceleration profile right under a crew seat or an on-board equipment are 

important for the design of a suitable shock isolation mount for crew and operation safety. These 

additional design requirements of a safe and robust planing hull require, not only the average 

design pressure, but the detailed structural responses in time of the boat at various concerned 

locations. This requires a detailed dynamic structural analysis of the flexible boat in a slamming 

event. 

Full simulation of a slam impact event for a planning hull is still under development, 

though significant advancement has been made recently. The challenges lie on its 

multidisciplinary nature, which requires intensive modeling and computation efforts. The 

emerging approach is to develop a unified set of governing differential equations to cover all 

involved disciplines which are then solved with a unified numerical mesh and algorithm. This 

approach is called closely coupled approach (Hou et al., 2012). Yang (2018) studied the breaking 
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water generated due to an impact generated by a free fall rigid body. He modeled three different 

domains: air, fluid, and rigid body, in the same form of Navier-Stokes equation in which the 

velocity and the pressure are the unknowns. This method has yet to be extended to planing hulls. 

As mentioned previously, the current approach is called loosely coupled approach (Yang & 

Huang, 2016). At each time instance, the approach uses separately developed numerical models 

to simulate waves, fluid, and vessel structure individually. Then, their solutions are reconciled 

based upon the common conditions, before moving on to the next time step. The main challenges 

of this approach lie on the difficulties to accurately trace the location of the moving boundary 

and transfer boundary velocity and pressure between different domains with different meshes. 

Various methods such as overset grids (Sukas et al., 2017) and immersed method (Yang, 2018) 

have been studied to overcome such issues of mismatched meshes. 

Ma and Mahfuz (2012) simulated the heave and pitch of a multi-hull ship model moving 

with a constant forward speed in a water tank.  Its hull panel, girders, and web frames were made 

of sandwich composite panels. The entire structure was discretized with 3,247 nodes and 3,162 

shell elements. ANSYS was used for a coupled fluid and structural analysis, incorporated with 

harmonic surface waves simulated by a 2D potential flow model. Their results demonstrated that 

it is important to take the elastic deformation into account in the FSI analysis as it affects the 

fluid pressure distribution around the ship hull.  To further study the detailed failure modes in the 

web-girder interface, the authors first identified the high stress area from the global FSI analysis 

which was carried out based on a coarse mesh. The local sub-model was then established around 

the high stressed area with refined meshes. The quasi-static analysis of the sub-model was then 

analyzed, subjected to the force and displacement values obtained in the global FSI analysis. Xie 

et al. (2018), investigated a water-entry hydro-elastic problem using FLUENT for fluid dynamics 
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simulation, ANSYS for structural analysis, and the volume of fluid method for air-water 

interface. A constrained minimization was constructed to convert the element center pressure 

output from FLUENT to nodal pressure input to ANSYS. The simulation results compared 

satisfactorily with water entrance testing data. 

Stern and his colleagues used their comprehensive CFDSHIP-IOWA, which models the 

viscous fluid domain with a moving interface boundary between the vessel and the fluid and 

models the free surface with level set method. The surface pressure was collected to simulate the 

motion of the vessel, which in turn altered the fluid domain boundary.  Overset gridding was 

used for data transfer between interfaced domains. This method enables visualization of physics 

details in fluid-structure interaction (Carrica et al., 2010). However, this method is 

computationally intensive. In their recent work, elastic deformation was considered only for part 

of the ship hull and solved by ANSYS finite element code (Volpi et al., 2017). The results 

compared favorably with the testing results in sea trials. Alternatively, fluid-structure interaction 

in time domain was carried out for a rigid vessel. The instantaneous surface pressure was then 

applied to the finite element model of the flexible vessel to find the dynamic responses in a 

quasi-static state (Volpi et al., 2017; Faltinsen, 2005).   

The studies of Garme, Rosen, and their colleagues (Garme & Rosen, 2003; Rozola et al., 

2014; 2016), focused on the motion profile of the planing hull. The approach they used may be 

termed as a single disciplinary approach. They solved only the equation of motion of a rigid 

planing hull for surging, heaving, and pitching subjected to the loads integrated from time 

dependent sectional pressures.  These sectional pressures were evaluated based upon the 

nonlinear strip theory, which was derived from a potential flow model for vertical impact of a 2D 

wedge. The advantage of this approach is its computational efficiency which enables the research 



9 

 

team to conduct numerical simulations for a long period of time so as to quantify the statistical 

nature of the acceleration time series. In their study, they pointed out the importance of maximal 

displacement and stress of panels for the lifelong design of a planing hull. These local structure 

responses are the result of local extreme pressure during slamming applied to the flexible boat 

hull, not the averaged design pressure. To address this issue, they (Rozola et al., 2014) built a 

finite element model of a section of a boat hull. Structure dynamic analysis was conducted then 

for the modeled section subjected to pressure distribution reconstructed from the pressure data 

collected from 12 pressure transducers. The pressure distribution reconstruction strategy was 

derived based upon the assumption that the fluid particle moves with the same speed from the 

keel to the chine on a section of the planing hull (Rosen & Garme, 2004; Rosen, 2005). 

The single disciplinary approach will be employed in this paper to investigate structural 

dynamic response of a planing hull slamming event. However, in this study, instead of pressure 

transducers, the data collected from accelerometers will be used as enforced excitation to 

simulate the slamming loads. Enforced excitation referred here is a type of dynamic response 

induced by the prescribed time-dependent boundary conditions prescribed in terms of 

displacement, velocity, or acceleration. Structural analysis through enforced excitation has been 

conducted on structures in the air and on the ground alike, most notably in the analysis of space 

shuttle main engine structures and the induced vibration of structures during earthquakes or on a 

shaker table. The large mass method is commonly used to enforce a single-degree boundary 

motion, in which the excitation force is equal to the acceleration multiplied by the mass value 

(Clough & Penzien, 1975). Davis et al., (2012) simulated the drop test response of onboard 

equipment through the use of a 6 degree-of-freedom (DOF) motion simulator. The enforced base 

excitation method proved successful by validation through frequency and transient responses, in 
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which the input was the motion profile measured by a single base accelerometer. In a broader 

view, a structure under enforced excitation can be formulated as a differential-algebra equation, 

which can be solved by introducing Lagrange multipliers to impose the prescribed boundary 

motion. The resultant set of equations can be solved by the elimination method or the penalty 

method (Chandrupatla & Belegundu, 2012).  The elimination method separates the 

displacements into the boundary set and the relative or the interior set (Cho et al., 2016; 

Flanigan, 1994; Bampton & Craig, 1968; Blades & Craig, 1997). The equation of motion of the 

entire structure is also reformulated into two.  One is an ordinary differential equation solved for 

the interior or the relative displacements while the other is an algebra equation directly used to 

compute the value of the Lagrange multipliers. The penalty method has been commonly used in 

finite element problems for static structural analysis or dealing with incompressibility conditions 

in velocity-pressure flow problems (Reddy, 1984), though seldom used in the time-dependent 

problems. The work of Liu & Lu (2010) is an example which applied the penalty method to 

count for earthquake base excitation in seismic analysis of structures. Scovazzi et al., (2017) 

proposed an interesting approach, which not only achieves accurate velocity as well as stresses 

but accommodates easily with enforced velocity and stress boundary conditions. Their equation 

of motion is expressed in terms of the first order time derivatives of stresses and velocities.  

This study will conduct the structural dynamic analysis of an 11-meter Rigid Inflatable 

Boat (RIB) under a slamming event. This is done by adopting the enforced motion analysis 

capability provided by the commercially available finite element analysis software, MSC 

NASTRAN, which is built upon the elimination approach. 
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2.2 Supplied Data 

Two previous Navy warfare center research efforts formed the foundation from which the 

current study was able to build upon. The first research effort included the initial modeling of the 

11-meter cabin RIB. The second research effort included sea trials on the 11-meter cabin RIB. A 

finite element model of the 11-meter cabin RIB, acceleration data from sea trials, and the 

StandardG algorithm were supplied to Old Dominion University in support of this study. An 

overview of the data each effort generated is discussed.  

Furthermore, full-scale vertical acceleration data on an 11-meter cabin RIB was collected 

by NSWCCD for a range of speeds and significant wave heights and made available to Old 

Dominion University’s Naval Engineering and Marine Systems Institute (NEMSI), along with a 

finite element model of the vessel. 

2.2.1 Finite Element Model 

 

In support of the Combatant Craft Division, NSWCCD Code 661 developed a finite 

element model of a Zodiac H1110 AFT IO CABIN RIB (Corbishdale, 2014). Modal analysis of 

the FEM was completed by Code 661 to aid the Combatant Craft Division selection of 

accelerometer placements before sea trials were conducted. The finite element model of the RIB 

was generated in FEMAP version 11.0, and NEiNASTRAN version 10.1 was used for modal 

analysis.  Due to unknown material, properties, and weights, assumptions were made in the 

development of the finite element model (Corbishdale, 2014). A smearing technique was utilized 

to distribute the mass of more complex features, such as windows, doors, inflatable sponson, and 

fuel. The finite element model weight of 15, 320 lbf was achieved with a final smearing of 3,650 

lbf over all primary structures (Corbishdale, 2014), which is consistent with the weight of the 
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actual planing craft. The elements used to build the finite element model, and their quantity, are 

provided in Table 1. 

 

Table 1. FEM Nastran Elements 

 

 

The longitudinal center of gravity (LCG) of the physical boat, as measured from the 

transom-keel intersection, was approximately 10.440 feet with an uncertainty of approximately 

±0.872 % (Murphy & Planchak, 2015).  The finite element model of the boat had the LCG 

located at approximately 135 inches (11.25 feet) as measured from the transom-keel intersection 

(Murphy & Planchak, 2015).  The difference between the LCG locations on the physical boat 

and finite element model is approximately 7.76 % which is well outside the uncertainty in the 

LCG measurement of the real-world boat.   

It is important to note that sea trials were conducted with a weight of 15,845 lbf with the 

addition of crew, seats, and instrumentation. Rack and bench removal from the cabin allowed for 

the addition of seats.  The additions and removals changed the LCG to 10.55 feet from the 

transom-keel intersection (Murphy & Planchak, 2015). 

Beginning in the summer of 2015, Old Dominion University students and NEMSI faculty 

advisors conducted an initial investigation to consider the use of full-scale vertical acceleration 

data as forced input for direct transient analysis of a high speed craft, using commercial finite 

element analysis software (Trenor, Sanders, Johnson, Michaeli, & Hou, 2015). Although 

Element Quantity

CBEAM 211

CONM2 4,372

CQUAD4 50,634

CTRIA3 798

RBE2 45
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completion of modal analysis was not one of the main objectives of this current study, the 

method utilized and associated results are discussed to provide total transparency into the 

research effort as a whole. Modal analysis of the finite element model was performed for three 

boundary conditions. The boundary conditions included an unconstrained condition, 1 Hertz 

springs, and 2 Hertz springs. The 1 Hertz spring constraints and 2 Hertz spring constraints were 

applied to the hull of the finite element model and allowed for the approximation of percent 

modal mass participation at various frequencies. The modes of interest included the primary hull 

bending mode and main deck flexural modes.  

Research at Old Dominion University commenced with the investigation into modal 

analysis data. As previously mentioned, NSWCCD Code 661 completed a modal analysis 

through the use of NEiNASTRAN. At Old Dominion University, MSC NASTRAN was used to 

complete a modal analysis of the finite element model developed by NSWCCD Code 661. The 

differences in results were then investigated.  Sample results from the three boundary conditions 

investigated are listed in Table 2. 

 

Table 2. MSC Nastran Modal Sample Results (Trenor et al., 2015) 

 

 

Modal analysis of the RIB was achieved through the creation and application of 1 hertz 

and 2 hertz springs upon the finite element model. Modal analysis results were compared against 

data provided in NSWCCD Code 60’s report for accuracy purposes. Comparison of the modal 

Mode f (Hz) % Errror Mode f (Hz) % Errror Mode f (Hz) % Errror

11 8.1375 0.76 7 8.1308 0.84 7 8.1309 0.84

17 12.657 0.45 14 12.64 0.32 14 12.65 0.4

12 8.8144 0.96 9 9.9449 0.48 9 10.066 0.48

No Boundary Conditions 1 Hz Springs Boundary Conditions 2 Hz Springs Boundary Conditions
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analysis completed in MSC NASTRAN to that conducted in NEiNASTRAN allowed for the 

adjustment of the model to a more accurate spring constant. During this investigation, 200 modes 

were analyzed and averaged for each condition analyzed. The MSC NASTRAN modal analysis, 

for the entire boat, yielded an averaged error of 1.16%, 1.20%, and 1.14% for the free boundary, 

1 Hertz springs, and 2 Hertz springs boundary conditions respectively (Trenor et al., 2015). The 

maximum error realized was that of mode 22 of the free boundary condition model, at 2.97% 

(Trenor et al., 2015). 

2.2.2 Acceleration Data 

In 2014, NSWCCD Code 835 completed sea trials on an 11-meter cabin RIB in an effort 

to investigate wave impact phenomena (Murphy & Planchak, 2015). During sea trials, 

investigators collected acceleration data through multiple sea states. The specific sea states are 

shown in Table 3 below. 

 

Table 3. Completed Seakeeping Runs  

 

 

 Column 1 provides the date that the data was collected. Column 2 details the name under 

which the dataset was saved. Column 3 is the average speed of the vessel while data was 

Date Target Seakeeping Run

Average Craft

Speed (kn)

Significant

Wave Height (ft)

Average Wave

 Period (s)

Feb 12, 2014 2014Feb12 Head Sea Max Safe Speed 25.7 3.9 5.6

Feb 12, 2014 2014Feb12 Head Sea 15kt Avg Speed 18.9 3.9 5.6

Feb 21, 2014 2014Feb21 Head Sea 15kt Avg Speed 14.9 3.9 5.7

Feb 10, 2014 2014Feb10 Head Sea Max Safe Speed 20.2 4.6 5.2

Mar 11, 2014 2014Mar11 Head Sea 20kt Avg Speed 20.5 2.2 7.2

Mar 12, 2014 2014Mar12 Head Sea 20kt Avg Speed 20.3 3.4 6.4

Feb 13, 2014 2014Feb13 Head Sea Max Safe Speed 19.0 5.0 6.2

Mar 11, 2014 2014Mar11 Head Sea Max Safe Speed 35.8 2.3 7.5

Mar 12, 2014 2014Mar12 Head Sea 30kt Avg Speed 30.4 3.4 6.4
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collected. Column 4 is the significant wave height, which “is the average of the one-third highest 

waves as measured from crest to trough during a wave measurement period” (Murphy & 

Planchak, 2015). Column 5 is the average period of the waves while data was collected. 

The data collected was categorized into three envelopes depending upon head-sea runs 

condition. The top three runs listed in Table 3 are where the significant wave-heights were about 

the same over three different average craft speeds and make up the Constant Wave Height 

Envelope. The middle three runs are where the average craft speed was approximately the same 

over three different wave-heights and make up the Constant Speed Envelope. The last three runs 

are where the RIB was at or near the maximum safe speed for the boat operator and makes up the 

Maximum Safe Speed Envelope. In-depth details of the data collection effort are presented in 

(Murphy & Planchak, 2015). 

2.2.3 StandardG Algorithm  

Wave impact response is a combination of rigid body motion, structural flexure, and 

vibration, as shown in Figure 1 (Riley & Coats, 2013). In an effort to retain and sort the 

accelerations that are not associated with local flexible body vibration, the StandardG algorithm 

was utilized. 
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Figure 1. Rigid Body Motion and Structural Flexure (Riley & Coats, 2013) 

 

The StandardG algorithm is a “standardized algorithm for extracting rigid body 

accelerations from acceleration data” (Riley & Coats, 2013). Also known as the Peak 

Identification Algorithm, it is one of the analysis methods employed by NSWCCD DN. “The 

peak-finding algorithm compares each point, ai, with a window of points between ai – time and 

ai + time. A value is considered a peak if it exceeds the amplitude threshold and is greater than 

the time threshold on either side of the point under evaluation. In short, the algorithm verifies 

that each peak is greater than the selected amplitude and only one peak occurs over the time 

threshold” (Murphy & Planchak, 2015). Figure 2 depicts the peak selection method performed 

on raw accelerometer data from sea trials. 
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Figure 2. Peak Extraction Plot from Accelerometer 11Z 

 

The StandardG algorithm processed all of the filtered acceleration data presented in this 

study. Although other software may be used to run the algorithm, MATLAB was utilized 

throughout the entire study. When running the program in MATLAB, the user is able to load 

acceleration data in the form of a Text File (.txt). Then, A Fast Fourier Transform (FFT) 

algorithm is used to plot amplitude versus frequency of the loaded data. A fourth order 

Butterworth low pass filter is then used to filter the loaded data to a user defined cutoff 

frequency. 

In order to reduce the amount of Nastran computations, the MATLAB file provided by 

NSWCCD Combatant craft was modified. However, the core operation of the StandardG 

algorithm was not altered. Further details of the modification are discussed in Chapter 3. 
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CHAPTER 3 

3. DYNAMIC RESPONSE MODELING OF A HIGH SPEED PLANING CRAFT WITH 

ENFORCED ACCELERATION 

This chapter is dedicated to the discussion of dynamic response modeling and the 

information necessary for its implementation. 

3.1 Equation of Motion under Base Excitation 

The derivation of equations associated with base excitation are presented hereafter. The 

theoretical formulations are the basic foundation for the operation of software used to complete 

enforced acceleration. The equation of motion is derived based upon Differential-Algebra 

Equation (DAE) point of view. 

The equation of motion of a free flexible structure under the given loading  tp  can be 

described as 

 tKCM pxxx    (1) 

where M , C and K are the mass, damping and stiffness matrices and  tp  and  tx  are the 

force and the displacement vectors. The displacement vector  tx  is unknown. The above 

equation maybe simplified as 

    xxpxxfx KCttM   ,,  

In the case of enforced motion, a given set of degrees of freedom of the system are subjected to 

enforced acceleration, which can be viewed as constraints imposed upon Eq. (1).  That is, 

 xxfx  ,,tM    subjected to  taxB   (2) 

where the displacement vector is divided into two parts, prescribed or free,  BI
T

xxx   of 

which the accelerations of degrees of freedom at Bx  are prescribed by given values,  ta . That is, 

the system equation is subjected to the constraint,  
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 tB ax   (3) 

This constraint is integrated which leads to the velocity and the position constrains 0uaxb
  t  and 

00 uuaxb  tt
2

1 2  , with given initial velocity and position, 0u   and 0u . As the displacement 

constraint is holonomic, Eq. (2) can be augmented by introducing the Lagrange multipliers λ  as  
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subject to two hidden constraints,  
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 (5) 

The most convenient approach to solve the DAE system, Eqs. (4) and (5), is by direct 

substitution.  The resultant equations become  






























af

af

λ

x

B BB

IBII

BI

II

M

M

IM

M 0
 (6) 

The first row of Eq. (6) is a typical ODE which can be solved with help of Eq. (3) as  

    aauuxxfxxxxfx III IBIIBIBBBIIII MtxMtM  ,,,,,,,,, 00
  

which leads to the solutions of  tIx  and  tIx .  The latter can be used to find the Lagrange 

multiplier in the second row of Eq. (6) as 

    aauuxxfxxxxfλ BB BBIBIIIBBBIBIBBII MxMtxMxMt   ,,,,,,,,, 00    

or more specifically,  

   afauuxxfλ B BBIBIIBIIIIBIII MMMMMMt   11
00 ,,,,,   

It should be noted that Eq. (2) can be extended to cases with enforced displacements and 

velocities in which the acceleration constraint is obtained through differentiation.  



20 

 

3.2 PATRAN and NASTRAN Solution Procedure for Enforced Acceleration 

Filtered Raw accelerometer data from sea trials was initially used as input for all dynamic 

response modeling. In order to allow for the import of acceleration data into PATRAN, each 

accelerometer dataset was saved as CSV files. Accelerometer data was assigned to finite element 

model nodes with the approximate locations of the accelerometer used during sea trials. For 

comparison purposes, specific accelerometers on the RIB pilot cabin were not enforced.  Within 

PATRAN, a transient response solution was requested. From PATRAN, a BDF file is generated 

with the prescribed enforced data. The BDF file is then imported into NASTRAN for 

computation of the requested transient response. From NASTRAN, an f06 file is generated with 

the requested data output. Detailed instructions are provided in Appendix A. Figure 3 displays 

the exact MSC NASTRAN commands and functions utilized to create the final load used during 

simulation. 

 

 

 

Figure 3. MSC NASTRAN Acceleration Input Flowchart 
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The NASTRAN solution procedure for this research centered on the SPC1 and TLOAD1 

arguments.  These commands allowed for direct input of acceleration data from the selected 

accelerometers into the NASTRAN solution. 

Acceleration data was input as TABLEDi data values and referenced into the SPC1 

arguments defined by SPCADD.  On the full boat analysis, there were 11 SPC1(s) that 

corresponded to 11 of the accelerometer locations.  The isolated cabin analysis used 7 input 

acceleration locations.  The acceleration data for one slam event from each accelerometer was 

input at the model nodal location that corresponded to the physical location on the real-world 

boat. 

The TLOAD1 arguments combined the SPC1(s) and the enforced motion SPCD’s.  The 

SPCD(s) were located at the same nodes as the SPC1(s).  These TLOAD1 commands were 

incorporated into the single DLOAD argument along with their respective load scale factors, and 

the solution process was then started. 

3.3 Full Boat Validation 

In order to be able to justify the use of stress and displacement results from the 

integration of the developed finite element model and sea trial data, it was necessary to first 

show that the integration of the two data types approximated real dynamic conditions. A 

summary of the method used during the full boat validation is provided in Figure 4. 
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Figure 4. Full Boat Validation Flowchart 

 

 The validation process began with analysis of the data collected during sea trials. Figure 

5 depicts a graphical representation of the raw experimental data for one subcase.  In order to 

extract the full boat acceleration without the noise from local flexible body vibration, all of the 

acceleration data was filtered at 10 Hertz. The selection of the cutoff frequency was selected by 

analysis of the spectrum plot created through the StandardG algorithm. As shown in Figure 6, the 

amplitude greatly diminishes after 10 Hertz. 
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Figure 5. Subcase 3 of Constant Speed Envelope: Accelerometer 1Z Raw Data Plot 

 

 

Figure 6. Subcase 3 of Constant Speed Envelope: 1Z Full Boat Spectrum Plot 
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 In order to reduce simulation time, the validation investigation focused upon a specific 

impact event during the experimental trial. Selection of a specific event within the sea trial data 

was completed through the use of the StandardG algorithm. Raw data from accelerometer 11Z, 

located near the longitudinal center of gravity, was used as a gauge for the sea trial event of 

interest. The peak acceleration from accelerometer 11Z marked the wave impact event to be 

studied. In addition to providing the peak acceleration, the StandardG algorithm also detailed the 

time at which the peak acceleration occurred. Following the location of the single highest 

acceleration near the LCG, modification of the StandardG algorithm was completed in order to 

collect data points before and after the time of the peak acceleration for a total of 2000 points 

over a 1 second event. Of the 2000 points within the 1-second interval 500 data points were used 

to represent the event by filtering for every fourth point. The selection of a 1-second interval was 

completed for each of the nine subcases. 

The process reduces MSC NASTRAN computation. Filtered and comparison plots of the 

data are provided in Appendix B. 

With filtered accelerometer data available, the next step was to find the locations that best 

estimated the actual placement of the accelerometers during sea trials.  Although the finite 

element model was highly detailed, the RIB and finite element model do not share all of the 

same structural components. Due to the differences in the experimental vessel and modeled 

vessel, only eleven sets of the available accelerometer data could be used as inputs during 

enforced excitation. The eleven accelerometers include 1Z, 2Z, 3Z, 4Z, 6Z, 7Z, 8Z, 9Z, 11Z, 

17Z, and 21Z. The locations of said accelerometers are presented in Figures 7 and 8. The current 

study made use of the accelerometers oriented in the vertical direction, which is normal to the 

deck. In Figure 7, the vertical accelerometers are designated with a red arrow. In Figure 8, the 
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vertical accelerometers are designated with a red dot. The physical locations of the vertical 

accelerometers on the 11m RIB used during sea trials are specified in Table 4 below. 

 

Table 4. Accelerometer Locations on 11-meter Cabin RIB 

 

 

 

 

 



26 

 

 

Figure 7. Side-View of 11-meter Cabin RIB Model with Accelerometer Locations  

 

 

Figure 8. Top-View of 11-meter Cabin RIB Model with Accelerometer Locations  
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In order to simulate the dynamic effects, the time-dependent accelerations were input 

through PATRAN and solved by MSC NASTRAN, a method that was previously discussed in 

section 3.2 and further divulged in Appendix A. During direct transient analysis of the model, 

numerical output of dynamic responses at selected nodes, 10Z, 13Z, and 16Z filtered at 10 hertz, 

were compared against collected acceleration data provided by NSWCCD Code 80’s sea trials. 

When implementing full-boat enforced acceleration, accelerometers 1Z, 2Z, 3Z, 4Z, 6Z, 7Z, 8Z, 

9Z, 11Z, 17Z, and 21Z were input at nodes 9131, 38278, 47452, 50220, 933, 5096, 10611, 

11521, 29178, 29640, and 29446 respectively. 

The above approach was taken for a total of three sea-keeping trial envelopes, each with 

three sub-cases, which are detailed in Table 3. Graphs of the filtered raw data and filtered MSC 

NASTRAN output for the three sea-keeping trial envelopes are shown below with their 

respective changes in standard deviation and root mean square mean deviation values. Microsoft 

Excel was used for the calculations of standard deviation and root-mean-square deviation. With 

respect to the investigation conducted, the calculations included: 

Letting the error be defined for every sampling time for a total of 500 sampled data in one 

second of an impact event, 

 For i = 1 to 500   

where is obtained from the filtered raw data collected from an accelerometer, while is 

from the filtered MSC NASTRAN simulation result. 

The mean of the error is obtained for n samples by, 

 

and its associated variance is obtained by, 
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with the square root of variance providing the standard deviation. The root-mean-square 

deviation is obtained by, 

 

The results and process are further summarized in the tables and figures displayed below. 
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The Constant Speed Envelope data, used to generate Figures 9(a), 9(b), and 9(c), was 

collected on February 10, 2014, March 11, 2014, and March 12, 2014 respectively, as listed in 

Table 3. The data of concern is grouped into three subcases. Subcase 1 was collected at average 

craft speed of 20.2 knots, significant wave height of 4.6 feet, average wave period of 5.2 

seconds, and is depicted in Figure 9(a). Subcase 2 was collected at average craft speed of 20.5 

knots, significant wave height of 2.2 feet, average wave period of 7.2 seconds, and is depicted in 

Figure 9(b). Subcase 3 was collected at average craft speed of 20.3 knots, significant wave height 

of 3.4 feet, average wave period of 7.2 seconds, and is depicted in Figure 9(c). Comparisons of 

the filtered MSC NASTRAN output to that of the full boat filtered raw data are shown in Figure 

9. 
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Figure 9. Filtered Constant Speed Envelope 
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The Constant Wave Height Envelope data used to generate Figures 10(a), 10(b), and 

10(c) was collected on February 12, 2014, February 12, 2014, and February 21, 2014 

respectively, as listed in Table 3. The data of concern is grouped into three subcases. Subcase 1 

was collected at average craft speed of 25.7 knots, significant wave height of 3.9 feet, average 

wave period of 5.6 seconds, and is depicted in Figure 10(a). Subcase 2 was collected at average 

craft speed of 18.9 knots, significant wave height of 3.9 feet, average wave period of 5.6 

seconds, and is depicted in Figure 10(b). Subcase 3 was collected at average craft speed of 14.9 

knots, significant wave height of 3.9 feet, average wave period of 5.7 seconds, and is depicted in 

Figure 10(c). Comparisons of the filtered MSC NASTRAN output to that of the full boat filtered 

raw data are shown in Figure 10. 
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Figure 10. Filtered Constant Wave Height Envelope 
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The Maximum Safe Speed Envelope data used to generate Figures 11(a), 11(b), and 11(c) 

was collected on February 13, 2014, March 11, 2014, and March 21, 2014 respectively, as listed 

in Table 3. The data of concern is grouped into three subcases. Subcase 1 was collected at 

average craft speed of 19.0 knots, significant wave height of 5.0 feet, average wave period of 6.2 

seconds, and is depicted in Figure 11(a). Subcase 2 was collected at average craft speed of 35.8 

knots, significant wave height of 2.3 feet, average wave period of 7.5 seconds, and is depicted in 

Figure 11(b). Subcase 3 was collected at average craft speed of 30.4 knots, significant wave 

height of 3.4 feet, average wave period of 6.4 seconds, and is depicted in Figure 11(c). 

Comparisons of the filtered MSC NASTRAN output to that of the full boat filtered raw data are 

shown in Figure 11. 
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Figure 11. Filtered Maximum Safe Speed Envelope 

 

 

 

 

 

 

 

 

 

 

 

 

 



35 

 

The investigation found that enforced acceleration upon the finite element model was 

able to yield results that correlated with the information obtained during sea trial data collection. 

The statement of correlation between the two sets of data is based upon graphical and numerical 

evidence. The graphical evidence is represented by time-dependent acceleration curves, while 

the numerical evidence included both the calculation of root mean square deviation and standard 

deviation. A compilation of the data calculations for the three envelopes is shown is Table 5. 

 

Table 5. Envelope Deviation (g’s): 11 Accelerometers as Input  

 

 

 The range of filtered root mean square deviation included a minimum of 0.1258 g’s, 

found through the Maximum Safe Speed Envelope, and a maximum of 0.5506 g’s, found 

through the Constant Speed Envelope. The range of standard deviation included a minimum of 

0.0032 g’s, found through the Constant Speed Envelope, and a maximum of 0.0206, found 

through the Constant Wave Height Envelope.  Overall, finite element model validation through 

enforced excitation by point accelerations and comparison to sea trial data was found to be 

effective.  

In this study, Constant Speed Envelope was the first envelope to be analyzed. Subcase 3 

of Constant Speed Envelope was found to correlate the best with filtered raw data, as supported 

by the calculations of root mean square deviation and standard deviation. In order to remain 

ENVELOPE SUBCASE 10Z RMSD 13Z RMSD 16Z RMSD 10Z STDEV 13Z STDEV 16Z STDEV

CONSTANT SPEED ENVELOPE SUBCASE 1 0.5506 0.4591 0.2606 0.0153 0.0069 0.0178

CONSTANT SPEED ENVELOPE SUBCASE 2 0.4965 0.4416 0.2239 0.0103 0.0032 0.0134

CONSTANT SPEED ENVELOPE SUBCASE 3 0.4863 0.4428 0.1725 0.0094 0.0036 0.0081

CONSTANT WAVE HEIGHT ENVELOPE SUBCASE 1 0.5199 0.4763 0.2237 0.0135 0.0171 0.0206

CONSTANT WAVE HEIGHT ENVELOPE SUBCASE 2 0.5224 0.4708 0.2046 0.0066 0.0092 0.0130

CONSTANT WAVE HEIGHT ENVELOPE SUBCASE 3 0.4950 0.4608 0.2137 0.0149 0.0068 0.0167

MAXIMUM SAFE SPEED ENVELOPE SUBCASE 1 0.5153 0.4869 0.1769 0.0146 0.0161 0.0112

MAXIMUM SAFE SPEED ENVELOPE SUBCASE 2 0.4957 0.4428 0.2113 0.0071 0.0042 0.0126

MAXIMUM SAFE SPEED ENVELOPE SUBCASE 3 0.4861 0.4477 0.1258 0.0090 0.0062 0.0059
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consistent, Subcase 3 of Constant Speed Envelope was used for completion of all subsequent 

investigations. The use of a single subcase was justified by the fact that the application of 

enforced acceleration, documentation of procedure, and analysis of effects were the core 

interests. The same procedures to be discussed can be completed on any of the nine subcases. 
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CHAPTER 4 

4. ENGINEERING APPLICATIONS 

This chapter is dedicated to the discussion of the effects of the number and placement of 

accelerometers. 

4.1 Sensitivity Study 

During the accelerometer sensitivity study of the model, dynamic responses at selected 

pilot cabin nodes were compared against collected acceleration data provided by NSWCCD 

Code 80’s sea trials, following the removal of selected accelerometer sets. The sensitivity study 

was conducted using full-boat enforced acceleration. Therefore, node and accelerometer listing 

remained consistent with the finite element model validation effort previously discussed in 

Chapter 3. 

In order to investigate the sensitivity, and or response, of the finite element model to 

reduction in the quantity of acceleration sensors and locate the most vital accelerometers, 

accelerometer outputs from 10Z, 13Z, and 16Z were used to gauge response quality. Due to the 

overall correlation found when conducting the finite element model validation investigation of 

Constant Speed Envelope at 20.3 knots and significant wave height of 3.4 feet, its data was used 

as a model dataset during completion of the sensitivity study. 

 The study commenced through the removal of any nodes not located along the RIB’s 

longitudinal center of gravity. This was accomplished by removing data associated with 

accelerometer 17Z and accelerometer 9Z, on the port side, and accelerometer 21Z on the 

starboard side to complete the first case study. From there, the effect of a single port or starboard 

input was investigated. This was accomplished by (1) removing data associated with 

accelerometer 17Z and accelerometer 9Z in the second case study, (2) removing data associated 
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with accelerometer 17Z and accelerometer 21Z in the third case study, and (3) removing data 

associated with accelerometer 21Z and accelerometer 9Z in the fourth case study.  

The final three cases investigated a symmetric input environment. In order to investigate 

a symmetric input scenario, (1) accelerometer 9Z was removed in the fifth case study, (2) 

accelerometer 9Z and accelerometer 4Z were removed in the sixth case study, and (3) 

accelerometer 8Z and accelerometer 9Z were removed in the seventh case study. Accelerometers 

were removed from the FE model through node deletion within PATRAN. The decision of 

accelerometer deletion and reapplication during the sensitivity study was wholly based upon 

changes in the root mean square deviation and standard deviation values. The procedure is 

further divulged in Appendix A. Intermediate evaluations are numerically summarized in Table 

6. 

 

Table 6. Filtered Subcase 3 of Constant Speed Envelope Deviation (g’s): Reduced Number 

of Accelerometers as Input  

 

 

The effect of the accelerometer deletions was also gauged by the percent difference 

calculated in association to each of the seven case studies versus the validation data. Equation 7 

was used to calculate the deviation. A summary of the data deviation is shown in Table 7 below. 

Filtered Case 10Z RMSD 13Z RMSD 16Z RMSD 10Z STDEV 13Z STDEV 16Z STDEV

Filtered Case 1 (17Z 21Z 9Z deleted) 0.5206 0.7231 0.3325 0.0515 0.0250 0.0358

Filtered Case 2 (17Z 9Z deleted) 0.4396 0.5111 0.3072 0.0383 0.0230 0.0287

Filtered Case 3 (17Z 21Z deleted) 0.4940 0.4996 0.3287 0.0513 0.0083 0.0334

Filtered Case 4 (21Z 9Z deleted) 0.4867 0.4473 0.2992 0.0558 0.0079 0.0268

Filtered Case 5 (9Z deleted) 0.4946 0.4196 0.1755 0.0095 0.0037 0.0086

Filtered Case 6 (9Z 4Z deleted) 0.4929 0.4232 0.1878 0.0098 0.0037 0.0100

Filtered Case 7 (8Z 9Z deleted) 0.5004 0.4032 0.1768 0.0095 0.0036 0.0089
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R refers to the result data in Table 6, and O refers to original data in Table 5 Subcase 3 of 

Constant Speed Envelope. 

%𝐷𝑖𝑓𝑓𝑒𝑟𝑒𝑛𝑐𝑒 =
(𝑅−𝑂)

(𝑅+𝑂)/2
∗ 100% (7) 

 

Table 7. Filtered Data Percent Difference  

 

 

The iterative method implemented during the study provided insight on how the location 

of accelerometers effects the overall correlation between sea trial and model data. The greatest 

deviation occurred with the changes to the presence of the port and starboard accelerometers. 

Graphical representation of the final evaluation is provided in Figure 12 below. 

 

 

 

Figure 12. Filtered Comparisons after Accelerometers 8Z and 9Z Deleted 

Filtered Case 10Z RMSD 13Z RMSD 16Z RMSD 10Z STDEV 13Z STDEV 16Z STDEV

Filtered Case 1 (17Z 21Z 9Z deleted) 6.8% 48.1% 63.4% 138.2% 149.1% 126.1%

Filtered Case 2 (17Z 9Z deleted) -10.1% 14.3% 56.2% 121.1% 145.3% 111.7%

Filtered Case 3 (17Z 21Z deleted) 1.6% 12.1% 62.3% 138.0% 78.1% 121.7%

Filtered Case 4 (21Z 9Z deleted) 0.1% 1.0% 53.7% 142.2% 74.1% 107.0%

Filtered Case 5 (9Z deleted) 1.7% -5.4% 1.8% 1.0% 1.1% 5.7%

Filtered Case 6 (9Z 4Z deleted) 1.3% -4.5% 8.5% 4.4% 1.7% 21.2%

Filtered Case 7 (8Z 9Z deleted) 2.8% -9.4% 2.5% 1.4% -0.8% 9.2%
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Alteration of quantity and placement for enforced acceleration input using sea trial data 

resulted in a 1.95% reduction in root mean square deviation when compared to the best-

correlating case of the finite element model validation investigation, based upon percent 

difference. The study was able to prove that the quantity of accelerometers can be reduced and 

still yield accurate results.  

 In summary, the removal of 8Z and 9Z displayed the best correlation when compared to 

the other 6 cases investigated. The removal of 8Z and 9Z also displayed a better correlation in 

terms of root mean square deviation when compared to the filtered raw data. However, none of 

the seven cases investigate yield better correlation in terms of standard deviation when compared 

to the filtered raw data. 

4.2 Displacement 

Deformation and fringe plots of the planing craft near the time of peak acceleration 

outputs from 10Z, 13Z, and 16Z are shown in Figures 13 and 14. The vessel was traveling at 

20.3 knots in waves heights of 3.4 feet. Max displacement of 0.811 inches was found at Node 

372. Additional deformation plots from varying time stamps are provided in Appendix C. Many 

of the same steps required for obtaining acceleration output were taken to retrieve displacement 

output, with a few key differences. During Step 6 of Appendix A, Displacements was selected 

instead of Accelerations, for Result Type, and request for output of the full finite element model 

was made by selecting All FEM, instead of 1, for Group(s)/SET.  
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Figure 13. Side View of Deformation plot at 0.31 seconds 

 

 

 

Figure 14. Top View of Deformation plot at 0.31 seconds 
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4.3 Cabin Sub-model Analysis  

Isolation of the pilot cabin was achieved through successive element reduction. In order 

to realize the isolated condition, the pilot cabin was separated from the main deck of the RIB. 

This stage of the investigation required the deletion of elements surrounding an approximate 75.5 

inch by 115-inch area within PATRAN. The result of said action is shown in Figure 15. Isolation 

of the pilot cabin in this manner yielded a RIB model with the locations of nodes associated with 

accelerometers 10Z, 13Z, and 16Z still intact for output purposes. It should be noted that 

although 10Z, 13Z, and 16Z remained intact, their output nodal number was altered from that of 

the previous investigations following the equivalence procedure to the remaining finite element 

model.  

 

 

 

Figure 15. Isolated Pilot Cabin 
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Due to the overall correlation found when conducting analysis of the Constant Speed 

Envelope at 20.3 knots and significant wave height of 3.4 feet, and for consistency, its data was 

used as a model dataset during completion of the isolated pilot cabin analysis. Accelerometer 

data was extracted from the full boat model in order to represent functioning accelerometers 

during sea trial data collection. The spectrum plot for the Constant Speed Envelope at 20.3 knots 

and significant wave height of 3.4 feet is displayed in Figure 16. The plot shows that the majority 

of major amplitude conditions occur until a frequency of 10 Hertz and 13 Hertz. In order to 

capture the accelerations associated with the rigid body of motion of the Constant Speed 

envelope subcase 3, the data was filtered separately at 10 Hertz and 13 Hertz. 

 

 

 

Figure 16. Subcase 3 of Constant Speed Envelope: 16Z Pilot Cabin Spectrum Plot 
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In order to enforce acceleration upon an isolated pilot cabin, selection of appropriate 

locations for base excitation accelerometers was required for implementation. Ideal locations for 

the nodes were assumed to be at the top of bulkheads, beneath the cabin, for the bulkheads’ 

rigidity. Due to the way in which the bulkhead intersections are offset from the base of the pilot 

cabin, as shown in Fig. 17, the locations of the nodes on the bulkheads were not within the pilot 

cabin section to be analyzed. Therefore, the nodes on the bulkheads were approximated with 

nodes on the cabin, which have similar x-y-z coordinates. Seven nodes at the intersection of the 

transverse and longitudinal bulkheads were approximated with nodes along the underside of the 

pilot cabin. Results from the full boat sensitivity study aided in the selection of the seven 

approximation nodes. Figure 18 is an underside view of the pilot cabin and shows the location of 

the seven nodes selected, marked by a red dot. The nodes are directly beneath the pilot cabin 

deck and directly above the transverse bulkheads. Due to the sensitivity study showing better 

correlation with a symmetric port and starboard acceleration input, the port and starboard each 

have three nodes. Due to the sensitivity study showing minimum correlation effect following the 

deletion of longitudinal nodes and the desire to use a minimum amount of data, only one 

longitudinal node was selected for input. The acceleration at the intersection of the transverse 

and longitudinal bulkheads served as a benchmark for the pilot cabin nodes to meet and a 

justification of the approximation made to continue this study. The assumption regarding similar 

acceleration values in a region near the intersection of the longitudinal and transverse beams was 

verified graphically and numerically, the latter through the calculations of root mean square 

deviation and standard deviation for the seven nodes selected. The deviation following 

approximation is minimal, as discussed below. 
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Figure 17. Side-View of 11-meter Cabin RIB Model Transverse Bulkheads 

 

 

 

 

Figure 18. Seven Node Locations on 11-meter Cabin RIB Model 
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Original Intersections were used for comparison purposes to verify the assumption. The 

difference in output between the bulkhead intersections and their approximations was found to 

be negligible, with a maximum root mean square deviation and standard deviation of 0.065 g and 

0.0015 g respectively. Graphical representations of their correlation are depicted in Appendix D, 

for both the 10-Hertz and 13-Hertz investigations. The acceleration profiles of the nodal 

intersection approximations are approximately the same as the acceleration profiles of the 

original intersection nodes. 

 The final evaluation utilized the approximated nodal outputs for enforced acceleration. In 

order to simulate the dynamic effects, the time-dependent accelerations were input through 

PATRAN and solved by MSC NASTRAN, a method which is further divulged in Appendix A. 

Dynamic responses at selected accelerometers, 10Z, 13Z, and 16Z, were compared against both 

acceleration data collected during sea trials and acceleration data collected during the full-boat 

model validation investigation, as shown in Figures 19 and 20. 
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Figure 19. Pilot Cabin Output Comparison with Data Filtered at 10 Hertz 

 

 

Figure 20. Pilot Cabin Output Comparison with Data Filtered at 13 Hertz 

 

 When filtered at a greater frequency, more motion was induced during enforced 

acceleration. Results show that there was a 16.5% reduction in standard deviation when filtered 

at 13 Hertz. Demonstration of the isolated pilot cabin provides proof that accuracy in output data 

can be maintained through a reduced test model.   

In addition to maintaining output correlation with sea trial data, by localizing the scope of 

the investigation stress contour plots of the pilot cabin, such as Figures 21 and 22, were realized. 

Local stress magnitude on the pilot cabin was obtained and can be used to aid in design changes. 

The maximum stress of the elements for both faces of the element are shown. The designation 

Z2 corresponds to the top face associated with the element normal vector, and the designation Z1 
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corresponds to the bottom face opposite the face normal. Figure 21 shows that there is a 

maximum Von Mises stress of 6.28 psi. Figure 22 shows that there is a maximum Von Mises 

stress of 6.48 psi. 

 

 

Figure 21. Stress Contour Plot using Data Filtered at 13 Hertz: Z2 Maximum Stress 

 

 

Figure 22. Stress Contour Plot using Data Filtered at 13 Hertz: Z1 Maximum Stress 
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 The final analysis of the cabin sub-model included two parts. Acceleration and stress at 

the finite element model seat pedestals were investigated. Node 5838 is located at the port seat 

pedestal and Node 4957 is located at the starboard seat pedestal. The acceleration plots for both 

locations are shown in Figure 23. Unlike the previous locations investigated, the lumped mass 

developed to represent the seats began to oscillate due to the wave impact. 

 

 

Figure 23. Node 5838 and Node 4957 Acceleration Plots 

 

 With stress being the cause of injury, the second step was to investigate the resulting 

stress profile that would be felt at the seat pedestals. In order to realize the stress profiles at the 

seat pedestals, shown in Figure 24, the stress profiles of the four CQUAD elements surrounding 

each of the two nodes were averaged. Figures 25 and 26 show the maximum stresses developed 

at the top and bottom of the shell elements surrounding Node 5838 respectively. Figures 27 and 

28 show the maximum stresses developed at the top and bottom of the shell elements 

surrounding Node 4957 respectively.  
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Figure 24. Node 5838 and Node 4957 Stress Plots 

 

Due to the fact that Von Mises stress is positive, stress peaks are followed by smaller 

spikes. This occurs throughout the stress profile plot. The stress output for the Starboard Seat 

Pedestal was the same for both faces of the element. However, the stress output for the Port Seat 

Pedestal showed a minor difference of 0.2 psi. 
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Figure 25. Cabin Stress Contour Plot at Z2: Port Seat Pedestal Node 5838 

 

 

 

Figure 26. Cabin Stress Contour Plot at Z1: Port Seat Pedestal Node 5838 
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Figure 27. Cabin Stress Contour Plot at Z2: Starboard Seat Pedestal Node 4957 

 

 

 

Figure 28. Cabin Stress Contour Plot at Z1: Starboard Seat Pedestal Node 4957 
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CHAPTER 5 

5. CONCLUSION AND RECOMMENDATIONS 

The development of methods and procedures to better understand the dynamic response 

of high speed planing hulls to wave impacts are necessary in order to mitigate risk to crew and 

equipment. In the current work, the approach was the use of acceleration data as an input.  

Investigations into the dynamic response of a high speed planing craft were completed by 

enforcing acceleration data at specific nodes and recording the resulting acceleration output at 

the bottom, midsection, and top of the pilot cabin. The resulting acceleration data was then 

validated through comparison to the acceleration output from sea trials. More specifically, this 

thesis demonstrated that the use of the finite element model is acceptable for dynamic simulation 

of the 11MRB0503 by showing that the rigid body accelerations output from the model correlate 

with the rigid body accelerations recorded during full scale sea trials. This was made possible 

through the use of the StandardG algorithm. 

The integration of captured accelerometer data and developed finite element data 

provided the ability to estimate cabin stresses without the use of strain gauges or pressure 

sensors. Separately, the two methods provide researchers with valuable information. However, 

when combined together the methods have the ability to provide further insight not witnessed 

through the use of either method alone. The integration of the two types of data yielded 

additional information not obtainable from either data type alone. 

An acceptable procedure for modeling dynamic responses of a high speed planing craft 

was developed. The method provides insight into where modifications are necessary and how 

modifications will perform under varying sea states. The methods and procedures used 
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throughout this work can be utilized on other structures, attached to large rigid structures (i.e. 

hull, bulkheads, deck plates etc.), were conducting live tests is costly. 

An actual comparison of the structural changes due to wave impact could not be 

completed since strain gauges or pressure sensors were not mounted before sea trials were 

conducted. It is recommended that such steps be taken to allow for a second means of validation. 

Results are largely dependent upon the accuracy of the initial finite element model. Greater 

efforts placed in the accuracy of the pilot cabin would yield more accurate results when 

compared to the sea trial data. Future investigations should focus on local modifications and their 

resulting effects.  Although large stress concentrations or deflections were not realized, the 

approach is documented and can be carried out by future researchers whom lack strain gauge or 

pressure transducer data from their experimental craft or structure.  
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Appendix A – PATRAN and NASTRAN Enforced Acceleration Procedure 

STEP 1: Double-Click on PATRAN  . 

Click on OK to accept the Message. 

Option 1: Click on File>Open> then Double-Click on> Appendix A> Cabin_No_Boundary 

for isolated cabin analysis.  

Option 2: Click on File>Open> then Double-Click on> Appendix A> Acceleration for full boat 

analysis. 

STEP 2: Click on Loads/BCs>Create Non-Spatial >Input 

Data…>Import/Export….  

At this point, each of the seven approximated nodal location’s data are imported, if conducting 

isolated cabin analysis. If conducting full boat analysis, each of the eleven nodal location’s data 

are imported. All of the data are in the form of CSV files. An example is provided below using 

file name “11073856”. 

Click on 11073856 >Apply>OK. 
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Create a Field Name > Click Apply. 

If correctly imported, ‘Existing Fields’ should show the ‘Field Name’ previously created as 

shown here . The procedure is repeated for the remaining CSV files. 

Remember to update the ‘Field Name’ before importing a new CSV file. 

STEP 3: Click on Create Load Case >Untitled.SC1>OK>Time Dependent. 

Set ‘Load Case Scale Factor’ to 1.0.  

The interface should resemble  . Click Apply>Yes Overwrite. 

STEP 4: Click on Acceleration  >Input Data…. 
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Type <,1.,> under ‘Trans Accel<A1 A2 A3>’ and Click on 11073856 for application to 

‘Time/Freq. Dependence’. 

The interface should resemble  . Click 

on OK>Select Application Region…>FEM.  

Type the desired nodal location for the enforced acceleration data to be applied

. Click on Add>OK. 

Create a New Set Name >Click Apply. This acceleration procedure is 

repeated for each CSV file initially imported. If correctly enforced, ‘Existing Sets’ should show

. Remember to update the ‘New Set Name’ and ‘Select Application 

Region…’ before applying a new set of input data. All data is enforced in the manner described 

above. 

In order to remove the enforced data set, as utilized during the Sensitivity Study, the user selects 

Delete for ‘Action:’ and Acceleration for ‘Object:’ 
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Click on the data that should be deleted under ‘Existing Sets’. The selected set of data should 

appear under ‘Sets to be Deleted’ and should resemble  . Click Apply. 

This step is repeated for any data set deemed unnecessary for the particular analysis. 

In order to analyze the FE model, a group is created for the critical outputs. As an example, 

accelerometers 10z, 13z, and 16z are considered to be the critical outputs. 

STEP 5: Click on Group>Create…> type a New Group Name >type the 

nodal locations that represent accelerometers 10z, 13z, and 16z.  

Under ‘Entity Selection’  , type node 9088 200 10043 when using the 

Cabin FE model and type node 25872 8508 18747 when using the Full Boat FE model. Click 
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Apply. If correctly implemented, the New Group Name will appear under ‘Existing Group 

Names’ as shown here  . 

STEP 6: Click Analysis. The Analysis tab should show  .  

Click on Solution Type…>TRANSIENT RESOPNSE> >OK. 

Click on Subcases…>Untitled.SC1>Subcase Parameters…>DEFINE TIME STEPS…>

>OK>OK>Apply>Cancel. 

Click on Subcases…> Untitled.SC1>Output Requests…>

>Accelerations for ‘Select Result Type’>1 for ‘Select Group(s)/SET’. 

The ‘Output Requests’ section should display . 

Click on OK>Apply>Yes>Cancel. 

Click on Subcase Select…>Unselect All>Untitled.SC1>OK. 

 In order to avoid confusion in the future, create a new ‘Job Name’ as shown here

. Click on Apply>OK>OK. If implemented correctly, 
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‘Available Jobs’ should display  and a new BDF file should have been 

generated in the same folder that was opened to initiate the procedure. 

Computations in NASTRAN can commence after a successful BDF file is generated with the 

desired enforced data. 

STEP 7: Double-Click on NASTRAN . 

Click on Appendix A_Procedure>Open>Run. This action will cause the generation of an f06 

file with the acceleration outputs previously specified.  
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Appendix B – MATLAB Data Plots 

 

Figure B1. Accelerometer 1Z Filtered Data Plot 

 

Figure B2. Accelerometer 1Z Data Comparison Plot 
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Appendix C – Deformation Plots  

 
Figure C1. Side View of Deformation plot at 0.02 seconds 

 

Figure C2. Side View of Deformation plot at 0.25 seconds 
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Figure C3. Side View of Deformation plot at 0.33 seconds 

 

Figure C4. Side View of Deformation plot at 0.55 seconds 
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Figure C5. Side View of Deformation plot at 0.75 seconds 

 

Figure C6. Side View of Deformation plot at 0.98 seconds 
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Appendix D – Approximation Validation Plots 

 

Figure D1. Original node 36754 versus Approximation node 35427 plot 

 

Figure D2. Original node 36643 versus Approximation node 34996 plot 

 

Figure D3. Original node 23849 versus Approximation node 24293 plot 
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Figure D4. Original node 23574 versus Approximation node 24084 plot 

 

Figure D5. Original node 10286 versus Approximation node 11073 plot 

 

Figure D6. Original node 10173 versus Approximation node 10948 plot 
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Figure D7. Original node 9812 versus Approximation node 10218 plot 
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